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2 Disclaimer

The actual version of this product (document) is available as is. TEC-IT declines all warranties
which go beyond applicable rights. The licensee (or reader) bears all risks that might take place
during the use of the system (the documentation). TEC-IT and its contractual partners cannot be
penalized for direct and indirect damages or losses (this includes non-restrictive, damages through
loss of revenues, constriction in the exercise of business, loss of business information or any kind of
commercial loss), which is caused by use or inability to use the product (documentation), although
the possibility of such damage was pointed out by TEC-IT.

=4 We reserve all rights to this document and the information contained therein. Reproduction,
use or disclosure to third parties without express authority is strictly forbidden.

B Fir dieses Dokument und den darin dargestellten Gegenstand behalten wir uns alle Rechte
vor. Vervielfaltigung, Bekanntgabe an Dritte oder Verwendung auferhalb des vereinbarten
Zweckes sind nicht gestattet.

© 1998-2026
TEC-IT Datenverarbeitung GmbH
Hans-Wagner-Str. 6

A-4400 Austria

t.: +43 (0)7252 72720

f.. +43 (0)7252 72720 77
www.tec-it.com
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3 Introduction

3.1 TFORMer9

The TFORMer product family represents a complete, lean and powerful solution for generating
arbitrary documents. It combines the features of barcode labeling tools with the characteristics of
report generators into a unified printing-solution. It provides professional layout and output capa-
bilities, an integrated barcode generator, full-featured UNICODE support, output streaming and

direct PDF generation.

3.2 Using the TFORMer SDK

TFORMer SDK provides the core output functionality of the TFORMer product family. It can be used
on client and on server side and it is available for all major operating systems. It can be embedded

in your own applications easily.

TFORMer Designer
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MASTER LABEL ==menes

Your Application (Client or Server)

TFORMer Designer is used for
creating and testing document layouts.

The finished layouts are accessible by

your application (or are distributed as
part of it).

KO
""‘:’..(

TFORMer SDK is TFORMer SDK

available for all
platforms.

Available APIs: JAVA,

.NET, COM, DLL or *
EXE.

TFORMer SDK is embedded into your
application.

The generated output is based on the
document layout and the data provided by
your application or database.
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The output created with a specific
document layout is identical regardless
of the output format chosen.

Figure 1: Using the TFORMer SDK

3.3 Areas of Application

Due to the support of multiple output formats TFORMer SDK has a wide field of applications:
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> Reporting Engine
For software developers the combination of TFORMer SDK and TFORMer Designer
provides a generic reporting solution which enables end-customers to create, edit and print
forms and labels.

» PDF Library
TFORMer SDK creates high-quality PDF documents based on graphical layouts.

» Industrial Printing
The built-in barcode support satisfies almost all industry labeling requirements.

» Client- or Server based Reporting
When it comes to web applications TFORMer SDK reduces round-trips and bandwidth
requirements. Direct printing or PDF generation from within Microsoft® Internet Explorer is
supported.

» Pre-Press and Print-Shop Applications
Mass-mailings and serial letters are created and printed within minutes.

3.4 Generating Output

For generating output, the following data must be specified:

= The document layout
= Dynamic data for printing
= QOutput device or output file

For passing the layout and data to TFORMer SDK you can choose between various methods:

Variable Data Document Layouts

m As File or URL

As Stream (BASE64 encoded)

b64

File or URL
(*.txt, *.csv, *.xml, ...)
xml .
TFORMer SDK la
(BASR64 encoded) TFORMer SDK is embedded into your
b64 application.

The variable data used for printing is passed
= as file, URL, stream, SQL SELECT
Via Program Code I ’ statement or via program code onto

dll TFORMer SDK.

Database

r - . =
| (SOLSELECT) Output Bs000 .
— 81210 125
_ Lt Device-independent Qutput
Note: Compressed (zipped) stk
streams and files are also M- =
accepted by TFORMer SDK. S

Figure 2: Generating output with the TFORMer SDK

A typical workflow is as follows:
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= In TFORMer Designer:

- Create a Template and save it
= |In TFORMer SDK:

- Select the created TFF file

- Define a data source

- Define an output type

- Print

3.5 This Document

This document provides a high-level introduction to the TFORMer SDK, with regard to the sup-
ported operating systems and the available APIs (Application Programming Interfaces). The target
audience are software developers and system administrators.

For more information about programming TFORMer SDK, please refer to chapter 5.
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4 Highlights of TFORMer SDK

4.1 Unified Output Solution

TFORMer SDK unifies output tasks. A specific form layout produces identical output across printer
models, operating systems and output formats. Supported output formats are:

= Direct Printing
Print layouts directly on all printers supported by Microsoft® Windows.
= PDF
PDF export with full-featured barcode support, Unicode and font embedding.
= PostScript®
Used for printing under Linux/UNIX and for pre-press applications.
= HTML'
The built-in HTML output is ideal for previewing and for web-based applications.
= Image Formats
The built-in image output supports BMP, GIF, JPG, PCX, TGA, PNG and TIF formats
(including multipage TIF).
= ZEBRA®
Print to ZEBRA® printers without any additional driver. ZPL-Il output is generated directly.
= ASCII
Pure ASCII output without any graphics for special purpose requirements.

4.2 UNICODE Support
The integrated UNICODE support allows you to use TFORMer SDK with almost any established
language.

4.3 Barcode Support

TFORMer SDK offers integrated support for all linear, 2D and composite barcodes in common use.

4.4 Streaming

Most of the supported output formats can be created as pure in-memory stream without temporary
files on the file-system.

4.5 Reusable, Smart Form Layouts

TFORMer SDK separates form layouts from the data. It does not bind form layouts to certain printer

models or databases. The output is dynamically controlled by means of layout properties,
conditional printing, tray control and individual computations.

" Due to the nature of HTML some output features may be limited or not available.
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4.6 Cross Platform

TFORMer SDK was designed to cover all operating systems in common use. It is available for
Microsoft® Windows and for major Mac® OS/Linux®UNIX® variants.

4.7 Small Footprint, High Performance

TFORMer SDK provides high performance PDF and printer output in combination with very low
system requirements.
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5 Documentation, APl Reference, Samples

5.1 Overview

For an overview over installed APIs, available Documentation and Samples open the Windows
Start-Menu and select TEC-IT TFORMer 9 SDK » Documentation.

These are the most relevant documents and samples:

5.2 API References and Manuals

= TFORMer SDK — DLL Programming Reference
This document describes the DLL API (Windows) as wells as the shared library API (Linux).
See Start Menu » TEC-IT TFORMer 9 SDK » DLL Programming Reference
Online: https://www.tec-it.com/Documentation/TFORMer9 Library Reference/index.html

= TFORMer SDK — COM Programming Reference
This document describes the COM programming interface.
See Start Menu » TEC-IT TFORMer 9 SDK » COM Programming Reference

= TFORMer SDK - .NET Programming Reference
This document describes the .NET programming interface.
See Start Menu » TEC-IT TFORMer 9 SDK » .NET Programming Reference
Online: https://www.tec-it.com/Documentation/TFORMer9 Assembly Reference/index.html

= TFORMer SDK - JAVA Programming Reference
This document describes the JAVA programming interface.
See Start Menu » TEC-IT TFORMer 9 SDK » JAVA Programming Reference
Online: https://www.tec-it.com/Documentation/TFORMer9 Java_Reference/index.html

= TFORMer SDK — TFPrint Command Line Printing Tool
This document describes the TFPrint command line printing tool.
See Start Menu » TEC-IT TFORMer 9 SDK » Documentation » TFORMer TFPrint User
Manual

= TFORMer Designer User Manual
This document provides an in-depth documentation of the graphical layout editor.
See TFORMer Designer: Menu » Help (or press F1).
5.3 Samples
= TFORMer SDK - Programming Samples
See Start Menu » TEC-IT TFORMer 9 SDK » Programming

5.4 Online FAQ

= Frequently asked questions (FAQs) and answers
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6 Installation on Microsoft Windows

6.1 Introduction

This chapter describes the installation of TFORMer SDK on Microsoft® Windows.

TFORMer SDK is available for 32-bit and 64-bit Windows. The installer contains both versions and
installs the correct version automatically. The 64-bit version additionally includes all 32-bit compo-
nents (like the 32-bit TFORMer COM API, etc.).

TFORMer SDK ships with some .NET based components like a .NET assembly and .NET sample
applications. If you are interested in these features, install the .NET Framework 4.5 (or higher)
before installing TFORMer SDK 8.1+.

Please note:
» Even though .NET is supported, the TFORMer SDK core components do not rely on .NET.

6.2 General

The installation of TFORMer SDK is straight-forward, the setup application will install the TFORMer
SDK components, sample applications and documentation.

The default installation path is one of the following:

C:\Program Files\TEC-IT\TFORMer9 SDK
C:\Program Files (x86)\TEC-IT\TFORMer9 SDK

Please note:
» On 32-bit Windows, only the 32-bit versions of the executables and DLLs are installed.

» On 64-bit Windows, the 64-bit and the 32-bit versions of the executables and DLLs are
installed, both in the same directory.

6.3 Supported APIs

After installation the functionality of TFORMer SDK is available via the following APIs:

» COM Component
This API is available via the file TFORMerCOMS9.dll. The COM component is registered
automatically by the setup application.

» .NET Component
The file TECIT. TFORMer.dll provides the .NET functionality (.NET 4.5 or higher is required).
The .NET assembly is automatically installed in the GAC as well as in the Bin directory.

> DLL
TFormer9.dll is a 32-bit Windows DLL, TFormer9x64.dll is the 64 bit variant of it (this naming
scheme applies to all DLLs as well). The corresponding library and include files are named
TFormer9.lib and TFormer9.h. For Linux and UNIX please refer to chapter 7.

» Command Line Application
The command-line based executable is named tfprint.exe. The command line application is
also available for Linux and UNIX. For details, please refer to chapter 7.
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> JAVA

The JAVA API can be integrated in J2EE architectures (web applications or web services)
and GUI applications (e.g. Swing, AWT). JAVA version 1.5 or higher is required.

6.4 Sample Applications

Depending on your Windows version the sample applications and layout templates are installed in
one of the following directories (please note that Windows Explorer does not display the folder
ProgramData by default, you need to enable Show hidden files and folders in the Folder and Search
options):

| C:\ProgramData\TEC-IT\TFORMer\9
or:

| C:\Documents and Settings\All Users\Application Data\TEC-IT\TFORMer\9
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7 Installation on Linux® or UNIX®

7.1 Introduction

This chapter describes the installation of TFORMer SDK on Linux® and UNIX® based operating
systems. Depending on the operating system TFORMer SDK is available as rom or tarball. For
details, please refer to section 7.5.

For a list of Linux or UNIX distributions which are supported with ready-to-run binaries please check
out www.tec-it.com. If you need binaries for your specific platform, please let us know. Whenever
possible, we provide them on request. In some cases, we perform remote builds after signing a
NDA.

> Please note that the report and label designer TFORMer Designer is only available for
Microsoft Windows.

7.2 General

The default installation path of TFORMer SDK is

| /usr/local/

The TFORMer SDK Command Line Application tfprint is installed into
| /usr/local/bin/tfprint

All configuration files, the license file TFORMer.ini and sample applications are located in the
following directory:

| /usr/local/share/TFORMer9/

This directory contains the following subdirectories:

= APIDocs: API references

= Copyright: this folder holds license information for used 3 party software

= Demos: contains sample shell scripts which demonstrate the use of tfprint (see chapter 13)
= Examples: contains folders with sample source code (see section 7.3)

= Templates: contains ready-to-use layout templates designed with TFORMer Designer

The directory also contains the Java library:
= JTFORMer9.jar

The include files needed for software development are stored in:

| /usr/local/include/TFORMer9/

The developer documentation for C++, Java and.NET is located in the following directory. Navigate
to the according sub-directory and open the file index.htm/ with your browser.

| /usr/local/share/TFORMer9/APIDoCS
Additional documentation is available through a man page.

$ man tfprint
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7.3 Supported APIs

After installation the functionality of TFORMer SDK is available via the following APIs:

» Shared Library
named libTFORMer9.so or libTFORMer9.a. The interface of the shared library is 100% com-
patible with the DLL API on Microsoft® Windows.

> JAVA API
the JAVA interface is available in the file JTFORMer9.jar.

> .NET API
the .NET interface is available in the file TECIT.TFORMer.dll and TECIT. TFORMer.Std.dll.

» Command Line Application
The command-line based executable is named tfprint

7.4 Sample Applications

The directory

| /usr/local/share/TFORMer9/Examples
contains a sample repository in the directory

= Demo Repository
The forms contained in this repository are used by sample applications.

Sample applications with source code are also included:

= C Command Line
This sample is written in C (TFORMerSimpleX.c). It generates barcode labels as a PDF
document.

= CSharp .NET Command Line
This sample demonstrates the use of the C# DLL with .NET for printing business cards from
the sample repository. Please note: This sample requires the TECIT.TFORMer.dll.

= JAVA Command Line
This sample demonstrates the use of the JAVA API for printing business cards from the
sample repository.

= JAVA (J2EE)
This sample demonstrates the use of the Java APl in a J2EE servlet. It generates barcode
labels as a PDF document.

7.5 Platform Specific Installation Hints

7.5.1 Linux® (deb- or rpom-based)

Before installing TFORMer SDK make sure to check if the following packages are available:

fontconfig-2.2.9

freetype2-2.1.7

libxml2-2.6.7

libxslt-1.1.14

cups-1.1.20 (or later)

unixODBC-2.2.11 (optional; only required if SQL is used)

libart 1gpl 2-2.3.19 (optional; only required for image, HTML and ZPL-II output)
freeimage-3.15.4
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Install the executables for TFORMer SDK (which also include some sample applications) with the
following command (as root-user) within the shell:

$ su
$ sh TFORMer-9.0.0-1.i586.rpm.bin

After confirming the license agreement with yes this script installs the rpm. After the installation you
will be asked if you want to generate a demo-report.

TFORMer SDK can be de-installed using the commands below:

$su
$ rom -e TFORMer

Install the executables for TFORMer SDK including some sample applications with the following
command (as root-user) within the shell:

$ sudo su
$ sh TFORMer-9.0.0-1-i386.deb.bin

After confirming the license agreement with yes this script installs the rpm. After the installation you
will be asked if you want to generate a demo-report.

TFORMer SDK can be de-installed using the commands below:

$ sudo su
$ dpkg -r TFORMer

7.52 HP-UX®(tarball)

Before installing TFORMer SDK make sure to check if the following packages are available:

freetype-2.1.10-ia64-11.23.depot

libxml2-2.6.23-1a64-11.23.depot

gettext-0.14.5-1a64-11.23.depot

libxslt-1.1.15-1a64-11.23.depot

expat-1.95.8-1a64-11.23.depot

lcms-1.15-1a64-11.23.depot.gz

z1ib-1.2.3-1a64-11.23.depot

fontconfig-2.3.2-1a64-11.23.depot

libiconv-1.10-ia64-11.23.depot

libart 1gpl-2.3.21-ia64-11.31.depot (only required for image, HTML and ZPL-II output)

A good place for downloading precompiled packages is: http://hpux.connect.org.uk/

TFORMer SDK installation is straight forward. TFORMer is distributed as tarball which includes an
install script.

$ gunzip SetupTFORMer-9.0.0-HPUX11.23-1A64.tar.gz
$ tar xf Setup TFORMer-9.0.0-HPUX11.23-1A64.tar
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$ cd SetupTFORMer
$ sh install.sh

After confirming the license agreement with yes this script installs TFORMer. After the installation
you will be asked if you want to generate a demo-report.

7.5.3 AIX®(tarball or rpm/bin based)

Before installing TFORMer SDK make sure to check if the following packages are available:

» Installation of the RPM package manager is a must!

AIX 4.3

rpm.rte.3.0.5.30
fontconfig-2.2.0-1.aix4.3.ppc.rpm
freetype2-2.1.5-1.aix4.3.ppc.rpm
libxml2-2.6.20-1.aix4.3.ppc.rpm
z1lib-1.1.4-3.aix4.3.ppc.rpm

AIX 5.x, AIX 6.1

rpm.rte.3.0.5.30
fontconfig-2.2.2-3.aix5.1.ppc.rpm
freetype2-2.1.7-2.aix5.1.ppc.rpm
libxml2-2.6.21-4.aix5.2.ppc.rpm
z1ib-1.2.2-4.aix5.1.ppc.rpm

libart 1gpl-2.3.17-4.aix5.1.ppc.rpm
libxslt-1.1.5-2.aix5.1.ppc.rpm

AIX 7.1

rpm.rte.3.0.5.30
libstdcplusplus-4.8.5-1.aix7.1.ppc.rpm
libgcc-4.8.5-1.aix7.1.ppc.rpm
libiconv-1.15-1.aix5.1.ppc.rpm
fontconfig-2.2.2-3.aix5.1.ppc.rpm
freetype2-2.1.7-2.aix5.1.ppc.rpm
z1ib-1.2.2-4.aix5.1.ppc.rpm

libart 1gpl-2.3.17-4.aix5.1.ppc.rpm

# Please do not use newer versions of libxml2 since they are buggy
libxml2-2.7.8-1.aix6.1.ppc.rpm
libxslt-1.1.5-2.aix5.1.ppc.rpm

It is necessary to extract some libraries from their archives and create symbolic links:

cd /opt/freeware/lib

# extract shared library and create a link
ar -x libfreetype.a

In -sf libfreetype.so.6 libfreetype.so

# extract shared library and create a link
ar -x libart 1gpl 2.a
In -sf libart 1gpl 2.so0.2 libart_ lgpl_ 2.so

Good places for downloading precompiled packages are:

= http://www-03.ibm.com/servers/aix/products/aixos/linux/download.html
= fip://ftp.software.ibm.com/aix/freeSoftware/aixtoolbox/RPMS/ppc
= http://www.oss4aix.org/download/RPMS/
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7.5.3.2 Installation from Tarball

The installation is identical to HP-UX (see section 7.5.2.2).

7.5.3.3 Installation from Rpm/bin

Install the TFORMer SDK by executing the downloaded bin file as script. Run the following
command (as root-user) within the shell:

$su
$ sh tformer-9.0.0-AIX-7.1-power7.bin

After confirming the license agreement with yes this script installs the rpm. After the installation you
will be asked if you want to generate a demo-report.

7.5.3.4 Rpm De-Installation
TFORMer SDK can be de-installed using the commands below:

$su
$ rom -e TFORMer

7.5.4 Solaris® (tarball)

7.5.41 Dependencies

Before installing TFORMer SDK make sure to check if the following packages are available:

freetype-2.3.1-s0110-x86-1local.gz
fontconfig-2.4.2-s0110-x86-1local.gz

7.5.4.2 Installation

To install TFORMer SDK for Solaris 10 perform the following steps:

gunzip TFORMer-9.0.0-solarisl0.x86.tar.gz
cp TFORMer-9.0.0-solarisl0.x86.tar /

cd /

tar xvf TFORMer-9.0.0-solarisl0.x86.tar

TFORMer is now installed in /usr/local/bin/

= The configuration file and documentation can be found in /usr/local/share/TFORMer9

= You should now be able to print a demo PDF by executing:
/usr/local/share/TFORMer9/Demos/DemoBarcodelabels.sh
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8 COM Component

8.1

Introduction

COM components (Component Object Model) are software components which can be integrated
seamlessly into other software products or used with development environments like:

Visual® Basic®, Visual C++, Visual Studio .NET, Visual Studio 2019 or higher, Borland C++
Builder, Borland Delphi, ...

Microsoft Office product suite (in conjunction with Visual Basic for Applications — VBA)
HTML pages on client- or server-side (ASP, ASP .NET, VBScript, Internet Explorer, ...)
Command-line based scripting environments (Visual Basic Scripting Host)

» Please note: COM technology is only available on Microsoft Windows.

8.2 Outline

» The name of the type library is TFORMer 9 Runtime Type Library.
» The GUID is 7709C4E4-4641-4B08-8BA6-8649E3672C32.
» The Class ID of the COM Control is AEB782F4-D12D-485F-BF49-1D602BD74BFS8.

The general steps for using the COM API of TFORMer SDK are:

1.

oo

o

7.

Embed the TFORMer COM component into your application or document. Usually this is
done by establishing a reference to the “TFORMer 9 Runtime Type Library”.

Create an instance of the “TFORMer9Lib. TFORMer” COM class.

Create a job-instance.

Create a jobdata instance and connect the job with it.

Set the properties of the job object (e.g. name of the form layout, output type and printer
name).

Provide or import the values for data fields via the jobdata object.
Finally call the Print method.

The general VBA-code for using TFORMer SDK looks as follows:

' This code snippet demonstrates the basic steps for using the TFORMer SDK - COM component
' from within VBA. Take care to establish a reference to TFORMer 9 Runtime Type Library
' beforehand!

Private Sub TFORMer Output ()

' Declare the variables

Dim TFormer

Dim PrintJob

Dim JobData As TFORMer9Lib.IJobDataRecordSet

' Create a TFORMer SDK instance

Set TFormer = CreateObject ("TFORMer9Lib.TFormer")

' Create a job object with TFORMer

Set PrintJob = TFormer.CreateJob
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' Create (and connect) the job data instance for providing data field values

Set JobData = printjob.NewJobDataRecordSet

' Select the form layout to be printed/generated, select type and name of the output
PrintJob.RepositoryName = "FILENAME OF YOUR FORMLAYOUT.tff"

PrintJob.OutputName = "C:\temp\output.pdf"

PrintJob.PrinterType = TECIT.TFORMer.PrinterType.PdfFile

' Provide data for the data fields used in the form layout

JobData.AddNewRecord
JobData.SetDataField "NAME OF YOUR DATAFIELD", "This is the value of the datafield"

' Start printing

printjob.PrintForm
End Sub

8.3 Using the COM Object in Development Environments

8.3.1 Microsoft Visual Basic for Applications (VBA)
Please refer to chapter 14, TFORMer SDK with Microsoft Office.

8.3.2 Other Development Environments

Please refer to the documentation of your development environment.

8.4 More Information

For more information, please check out the following documents and sample applications (see also
chapter 5):

= COM Programming Reference

Start Menu » TEC-IT TFORMer 9 SDK » COM Programming Reference
= Sample Microsoft® Excel Spreadsheet using TFORMer SDK

Start Menu TEC-IT TFORMer 9 SDK » Microsoft Office
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9 .NET Component

9.1 Introduction

The TFORMer SDK .NET component is perfectly suited for application development with any .NET
programming language.

= On Microsoft Windows the setup application installs the TFORMer assembly automatically
in the GAC (Global Assembly Cache) and in the Bin subdirectory of the TFORMer SDK
default installation path. The .NET classes can be used immediately with development
environments like Microsoft Visual Studio.

= Alternatively, the TFORMer assembly is also available as NuGet package:
https://www.nuget.org/packages/TECIT.TFORMer

» On Microsoft® Windows the TFORMer SDK .NET component requires .NET 4.5 or higher.
» On Linux/UNIX TFORMer SDK for .NET works with .NET Core / .NET 5+.

9.2 Outline

» When establishing a reference, the name of the .NET component is TFORMer 9 SDK (file
TECIT.TFORMer.dll).

The general steps for using the TFORMer SDK .NET assembly are:

Establish a reference to TFORMer 9 SDK.

Depending on the programming language include the TECIT.TFORMer namespace.
Create a job-instance (TECIT. TFORMer.Job).

Create a jobdata instance (TECIT. TFORMer.JobData or derived classes).

Connect the job with the jobdata.

Set the properties of the job to the required values (e.g. name of the form layout, output type
and printer name).

Provide or import the values for data fields via the jobdata.
8. Finally generate the required output with the Print method.

ook wh =~

N

The general code for using TFORMer SDK in C# .NET looks as follows:

// This code snippet demonstrates the basic steps for using the TFORMer SDK from within
// C# .NET. Take care to establish a reference to TFORMer 9 SDK from within your project!

using TECIT.TFORMer;

private void PrintWithTFORMer ()
{

// Create a new Job instance

Job printJob = new Job () ;

// Select the form layout (stand-alone or Repository-based)

// If you are using a Repository you need to specify the Project (Job.ProjectName)

// and the FormLayout (Job.FormName) as well.

printJob.RepositoryName = "FILENAME OF YOUR FORMLAYOUT.tff";
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// Provide the data for the data fields used in the form layout.
// Here we use an in-memory data source for manually providing the data.

JobDataRecordSet jobData = new JobDataRecordSet () ;

Record record = new Record();

record.Data.Add ("NAME OF YOUR DATAFIELD", "This is the value of the datafield");
jobData.Records.Add (record) ;

record = new Record();

record.Data.Add ("NAME OF YOUR DATAFIELD", "This is a second datafield value");
jobData.Records.Add (record) ;

// Assign the JobData to the Job

printJob.JobData = jobData;

// Select the Windows or Linux (CUPS) printer name, use null for the default printer
printJob.PrinterName = null;

// Start printing

printJob.Print () ;

9.3 Additional Samples

9.3.1 Print to PDF
// Create a new Job instance
Job printJob = new Job () ;
// Select the form layout
printJob.RepositoryName = "FILENAME OF YOUR FORMLAYOUT.tff";

// Provide the data for the data fields used in the form layout.
// Here we import data from an ODBC connection using the specified SQL SELECT statement.

JobDataOdbc jobData = new JobDataOdbc (
"DSN=TFORMer Sample",
" // Username
", // Password
"SELECT * FROM tbl Example"
)
// Assign the JobData to the Job
printJob.JobData = jobData;
// Select type and name of the output

printJob.OutputName = "C\temp\output.pdf";
printJob.PrinterType = PrinterType.PdfFile;

// Print it

printJob.Print ();

9.3.2 Save a PNG Thumbnail

// Create a new Job instance

Job printJob = new Job () ;
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mk:@MSITStore:C:/Project/TEC-IT/TFORMer/trunk/_doc/TFORMerNET_Doxy/TFORMerNET_Reference.chm::/namespace_t_e_c_i_t_1_1_t_f_o_r_mer.html#a796ea483d73e01544b5fe3a1cd8fdaf7

// Select the form layout

printJob.RepositoryName = "FILENAME OF YOUR FORMLAYOUT.tff";

// Provide the data for the data fields used in the form layout.
// Here we import a CSV file and specify separator and qualifier characters.

JobDataCsv jobData = new JobDataCsv ("/temp/Import.txt", ',', "'"');
// Assign the JobData to the Job

printJob.JobData = jobData;

// Select type and name of the output

printJob.OutputName = "C:/temp/output.png";
printJob.PrinterType = PrinterType.ImagePng;

// Set the output resolution to 96 dpi (= screen resolution)
printJob.Options = "resolution=96";
// Print it

printJob.Print ();

9.4 More Information

For more information, please check out the following documents and sample applications (see also
chapter 5):

= _.NET Programming Reference
Start Menu » TEC-IT TFORMer 9 SDK » .NET Programming Reference

= Sample Code
Start Menu » TEC-IT TFORMer 9 SDK » Programming
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10 DLL (Dynamic Link Library)

10.1 Introduction

Besides the COM and .NET Interface, the TFORMer SDK contains also a Microsoft® Windows DLL
(32 bit/64 bit). A DLL is a library, which offers its functionality via a documented interface. DLLs can
be used in

= Most programming languages and development environments (e.g.: Visual C/C++, .NET, all
versions of Visual Studio, Visual Basic, Borland C++ Builder, Borland Delphi, ...)

= Web-based scripting languages like PHP

» Please note: The DLL is only available on Microsoft® Windows. If you need to use a DLL-like
interface on Linux/UNIX please use the shared library (see chapter 11).

10.2 Compiling Your Applications

The files TFormer9.lib (library) and TFormer9.h (header file) are required to compile and link your
own applications with the TFORMer DLL. These files are usually stored in one of the following
folders:

C:\Program Files\TEC-IT\TFORMer9\Bin
C:\Program Files (x86)\TEC-IT\TFORMer9\Bin

Make sure the compiler and the linker are able to locate these files.

10.3 Outline

The general steps for using the TFORMer DLL are:

1. Include TFormer9.h. Make sure to define TECIT_DLLIMPORT before including the header
file.

Initialize the TFORMer DLL and save the handle (TFormer_Init).

Select the form layout to be printed (TFormer_SetRepositoryName).

Select the type of the output and the target file or device (TFormer_SetPrinterName).
Provide values for datafields (if any) in the form layout.

Generate or print the output (TFormer_Print).

7. De-initialize TFORMer SDK (TFormer_Exit).

oA WD

The general C-code for using TFORMer DLL looks as follows:

// This is not a complete application. It is just a sample without any error handling
// to demonstrate the basic steps for using the DLL interface

//

// define TECIT DLLIMPORT before including TFormer9.h!

#define TECIT_DLLIMPORT

#include "PATH TO_TFORMER/TFormer9.h"
#undef TECIT DLLIMPORT

// Handle for TFORMer SDK

HTFORM hTForm = NULL;
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// Initialize TFORMer SDK

hTForm = TFormer Init (NULL);

/* Select the form to be printed

TFormer SetRepositoryName (hTForm, "FILENAME OF YOUR FORMLAYOUT.tff");
/* Use the default printer of the system */

TFormer SetPrinterName (hTForm, NULL, NULL);

/* Add a Data record */

TFormer NewRecord (hTForm);

/* Set a Datafield value */

TFormer SetVarValue (hTForm, "NAME OF YOUR DATAFIELD", "Value of the datafield");
/* Start printing */

TFormer Print (hTForm);

/* Exit TFORMer */

TFormer Exit (hTForm);

10.4 More Information

For more information, please check out the following documents and sample applications (see also
chapter 5):

= DLL Programming Reference
Start Menu » TEC-IT TFORMer 9 SDK » DLL Programming Reference

= Sample applications with source code
Start Menu » TEC-IT TFORMer 9 SDK » Programming

= Appendix B describes how data is provided to TFORMer SDK.
= Appendix C describes how to adjust general output options.
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11 Shared Library

11.1 Introduction

A shared library on Linux or UNIX is the counterpart to a DLL on Microsoft® Windows. Such a library
offers its functionality via a documented interface to applications. All programming languages on
Linux/UNIX are able to use shared libraries.

» Please note: The shared library is only available on Linux/UNIX. If you need to use a similar
interface on Microsoft® Windows, please use the DLL (see chapter 10).

11.2 Compiling Your Own Applications

The following files are required to build your own applications with the shared library:

=  TFormer9.h: This is the include file for the TFORMer SDK shared library API.
= TECITStd.h: An additional include file for Linux/UNIX.

= [ibTFORMer9.so: This is the shared library.

= [ibTFORMer9.a: This is the static library version of TFORMer SDK.

After the shared library of TFORMer SDK has been installed the include files TFormer9.h and
TECITStd.h are stored in:

/usr/local/include/
/usr/local/include/TECITSTd/

Make sure the compiler and the linker are able to locate these files. Compile and link your applicati-
ons with a command similar to the following (see also the shell script build_sample.sh):

$ gcc TFORMerSimpleX.c -o TFORMerSimpleX -Idl —ITFORMer9 -L/usr/local/lib -l/usr/local/include

11.3 Outline

The general steps for using the shared or static library are:

1. Make sure to define TECIT_DLLIMPORT and _TEC_UNIX and TEC_UNIX_BUILD.

Depending on your platform define TEC_LINUX, TEC_FREEBSD, TEC_AIX, TEC_HPUX,
TEC_SOLARIS, TEC_0OS400 or TEC_SCO. Only one platform is allowed!

Include TECITStd.h and TFormer9.h.

Initialize the TFORMer Shared Library and save the handle: TFormer_Init ()

Select the form layout to be printed: TFormer_SetRepositoryName()

Select the type of the output and the target file or device: TFormer_SetPrinterName()
Provide values for datafields (if any) in the form layout.

Generate or print the output: TFormer_Print()

De-initialize the TFORMer Library: TFormer_Exit()

N

© 0N oKW
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The general C-code for using TFORMer SDK looks as follows:

// This 1is not a complete application. It is just a sample without any error handling
// to demonstrate the basic steps for using the DLL interface

;; define TECIT DLLIMPORT before including TFormer9.h!

#define TECIT DLLIMPORT

/* Enable a TFORMer Unix build using the two defines below */

#define TEC_ UNIX
#define TEC UNIX BUILD

/* Set the define for the concrete OS you are using */

#define TEC LINUX

/* #define TEC_FREEBSD */

/* #define TEC_AIX */

/* #define TEC_HPUX */

/* #define TEC_ SOLARIS */

/* #define TEC_0S400 */

/* #define TEC_SCO */

/* include the TECITStd header for required defines */

#include <TECITStd/TECITStd.h>

/* include TFORMer9.h */

#include <TFormer9.h>

/* undefine - as they are only required for TFORMer Header files */
#undef TECIT_DLLIMPORT

#undef TEC UNIX

#undef TEC UNIX BUILD

// Handle for TFORMer SDK

HTFORM hTForm = NULL;

// Initialize TFORMer SDK

hTForm = TFormer Init (NULL);

/* Select the form to be printed

TFormer SetRepositoryName (hTForm, "FILENAME OF YOUR FORMLAYOUT.tff");
/* Use the CUPS default printer of the system */

TFormer SetPrinterName (hTForm, NULL, NULL);

/* Add a Data record */

TFormer NewRecord (hTForm);

/* Set a Datafield value */

TFormer SetVarValue (hTForm, "NAME OF YOUR DATAFIELD", "Value of the datafield");
/* Start printing */

TFormer Print (hTForm);

/* Exit TFORMer */

TFormer Exit (hTForm);
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11.4 C Sample Application

A sample application which uses the shared library is installed in:

| /usr/local/share/TFORMer9/Examples/C Command Line

This C code generates a PDF file with barcode labels. The sample application uses the same docu-
ment layout as the script DemoBarcodelLabels.sh mentioned in section 13.3.2.2. Datafield values
are passed programmatically.

Compile it by executing:

$ gcc TFORMerSimpleX.c -o TFORMerSimpleX -ldl —ITFORMer9 -L/usr/local/lib -l/usr/local/include

11.5 More Information

For more information, please check out the following documents and sample applications:

= Programming References
| /usr/local/share/TFORMer9/APIDocs
=  Sample Applications with source code (C, C#, Java)

| /usr/local/share/TFORMer9/Examples

= Appendix B describes how data is provided to TFORMer SDK.
= Appendix C describes how to adjust general output options.
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12 Java Component

12.1 Introduction

The Java component of TFORMer SDK is a Java Native Interface (JNI) software layer between the
TFORMer SDK (DLL/Shared Library) and the Java Virtual Machine. The architecture of this wrapper
is composed by:

= The library TFORMer9 (DLL or shared library), in order to execute the TFORMer SDK;

= The JNI library TFORMer9JNI (DLL or shared library), to translate the Java calls to the
TFORMer SDK requests and responses;

= The Java library TFormer9.jar, to simplify the access to the TFORMer SDK.

In particular, the Java library is built following the .NET architecture in order to maintain a simply
and uniform program interface. It's important that the paths of the TFORMer SDK — DLL (or shared
library on UNIX platform) and the JNI library are included into the java.library.path of the Java
Virtual Machine: so, you must ensure that your system respects one of the following cases: these
libraries are

= defined into the environment variable PATH (Windows), LD_LIBRARY _PATH (Linux and
Macintosh), SHLIB (HPUX) or LIBPATH (AlX);

= defined into the parameter -Djava.library.path of the java command;

= defined as system libraries.

As usual the Java library (JTFormer9.jar) must be included in the classpath of the javac/ava
command in order to compile and execute your projects.

12.2 Outline

The general steps for using the Java component of TFORMer SDK are:

1. Include the com.tecit. TFORMer and com.tecit. TFORMer.Printing namespaces.
2. Create a job-instance (com.tecit. TFORMer.Printing.Job).

3. Create a jobdata instance (with the derived classes of
com.tecit. TFORMer.Printing.JobDataSource).

4. Connect the job with the jobdata instance.

5. Use the setter methods of the job to define the required values (e.g. name of the form layout,
output type and printer name).

6. Provide or import the values for data fields via the jobdata instance.

7. Generate the required output with the print method.

8. Finally free the resources allocated using the dispose method.

The general Java code for using TFORMer SDK looks as follows:

// This code snippet demonstrates the basic steps for using the TFORMer SDK from within
// Java. Take care to include the TFORMer Java library in your project and to include the
// TFORMer SDK and JNI DLL/shared library into the java.library.path

import com.tecit.TFORMer. *;

import com.tecit.TFORMer.Enumerations.*;

import com.tecit.TFORMer.Printing.JobDataRecordSet;

import com.tecit.TFORMer.Printing.Job;

import com.tecit.TFORMer.Printing.JobDataRecordSet.Record;

private void printWithJTFORMer ()
throws TFormerException

{
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// Create objects for a job and a jobdata
// NOTE: the constructor can generate an exception if the TFORMer SDK is not
// accessible (java.library.path doesn't contain the TFORMer DLLs or shared libraries)

Job job = new Job();
JobDataRecordSet jobdata = new JobDataRecordSet () ;

try {
// Connect the jobdata with the job
job.setJobData (jobdata) ;

// Select the form layout to be printed/generated,
// adjust the type and name of the output

job.setRepositoryName ("FILENAME OF YOUR FORMLAYOUT.tff");
job.setOutputName ("C:\\temp\\output.pdf") ;
job.setPrinterType (EPrinterType.PDFFile) ;

// Provide data for the data fields used in the form layout

Record record = new JobDataRecordSet.Record() ;
record.setData ("NAME OF YOUR DATAFIELD", "This is the value of the datafield");
jobdata.add (record) ;

// Start printing

job.print ()
}
catch (TFormerException ex)

{

throw ex;

}
Finally

{
// ALWAYS call dispose in order to free the TFORMer SDK resources
job.dispose () ;

job = null;
}

> Please note: In order to free the resources allocated by TFORMer SDK, it's important to call
the method dispose of the JTFormer classes. A use of the TFORMer Java classes without
the invocation of the method dispose can cause memory allocation problems and leaks.

12.3 More Information

For more information, please check out the following documents and sample applications (see also
chapter 5):

= Java Programming Reference
Start Menu » TEC-IT TFORMer 9 SDK » Java Programming Reference

= Sample Code
Start Menu » TEC-IT TFORMer 9 SDK » Programming
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13 Command Line Application

13.1 Introduction

The TFORMer SDK command line application is available for Microsoft® Windows, Linux® and
UNIX®. It generates output based on arbitrary form layouts created with TFORMer Designer.

The executable is named tfprint (or tfprint.exe on Microsoft® Windows) and can be used

= onits own (executed manually)

= as part of batch jobs or shell scripts

= via “shell-execute” as “out-of-process” reporting engine
= as extension for printer filter applications on Linux/UNIX

13.2 Outline

The general steps for using tfprint are:

1. Create the required form layouts using TFORMer Designer.
2. Provide data for the form layouts via XML, CSV, TXT or ODBC datasources.
3. Embed tfprint into your batch-job, shell script or applications.

» On Microsoft® Windows the files for the form layouts or file-based datasources (XML, CSV or
TXT) may be provided as a filename (as file stored in the file system) or as http-based URL.

TFPrint V9.0.0.31157 SDK - Command-Line TFORMer Reporting Engine
(c) 1998-2025 TEC-IT Datenverarbeitung GmbH
https://www.tec-it.com

tfprint -F (Repository Project FormLayout) | FormLayoutFile
[ -D DataFile or DataSourceName ]
[ =DT (XML |TEXT|TFORMER|TFS|ODBC|DATASOURCE) ]

-D0 [CL[yes|nol]l [ESC[yes|no]l] [SCc] [QCc] [RCFname|RCAname]
[DSN:name [USER:user] [PWD:password] SQL:statement] [XSLT:file] ]
[ParamName:value] ]

-0 DevOrFile ]

—0T (WIN32|REPO|PS|PSPRINTER|PDF|PDFA|HTML | TXT|TXTPRINTER | IMGBMP |
IMGGIF | IMGJPG | IMGPCX | IMGPNG | IMGTGA | IMGTIF | IMGMULTITIF|ZPL|
ZPLPRINTER | ZUGFERD | SVG|SVGZ) 1]

—00 [cPn] [TCname] [SRn] [Scn] [DXN] [DXH] [DXv] [JTtitle] ]

-L (ActivationCode LicenseeName LicenseKind NumberOflLicenses

LicenseOptions ExpirationDate Signature)
| béu:<base6UData> | file:<licenseFile> ]

-Q ]

—C CommandFileASCII ]

—-LcuPs ]

—SYSTEMID ]

-CONFIG File ]

-SDK Options ]

-H | -2 ] Show detailed help

Figure 3: tfprint command line parameters

When using tfprint to generate output you need at least 3 parameter groups:

= the form layout (command line parameter —F)
= the datasource (command line parameters —D, —DT, —DO)
= the type and target of the generated output (command line parameters —O, —OT, —OO)
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13.3 Samples

13.3.1 For Microsoft Windows

In the example below tfprint is used to generate a form layout (MyLayout.tff) using the datasource
MyValues.txt (a datasource contains values for datafields) as a PDF document named Output.pdf:

tfprint -F MyLayout.tff -D "MyValues.txt" -DT TEXT -DO SC, QC\" -O Output.pdf -OT PDF

Numerous sample applications are installed by the setup application — check out the following menu
entry for details:

Start Menu » TEC-IT TFORMer 9 SDK » Command Line Printing TFPrint
13.3.2 For LINUX and UNIX

13.3.2.1 Generate all Templates as PDF

In order to generate all form layouts stored in the Templates directory as PDF-files execute the
following script:

$ sh /usr/local/share/TFORMer9/Demos/DemoPDF.sh

The resulting PDF-files are created in your current working directory. The generated PDF files will
need about 60 MB of disc space!

13.3.2.2 Generate Barcode-Labels (PDF-Output)
This script generates barcode labels as PDF-file:
$ sh /usr/local/share/TFORMer9/Demos/DemoBarcodelabels.sh

The layout for the label is stored in the demo repository. The result is created in your current
working directory.

13.4 More Information

For more information, please check out the following documents:

= Check out the TFPrint User Manual.
Start Menu » TEC-IT TFORMer 9 SDK » Documentation » TFORMer TFPrint User
Manual

= Execute tfprint —h to display a detailed description of the command line parameters. On
Linux/UNIX type man tfprint to display the man-pages.

= Check out the TFORMer Designer User Manual
Start Menu » TEC-IT TFORMer 9 » TFORMer Designer Manual

= Appendix B describes how data is provided to TFORMer SDK.

= Appendix C describes how to adjust general output options.
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14 TFORMer SDK with Microsoft Office

14.1 Introduction

Most applications of the Microsoft® Office Suite are supporting the Component Object Model
(COM). That means that COM-compliant software components like the TFORMer SDK can be
embedded and programmed directly as part of documents, spreadsheets, forms or databases.

The integration of COM components into the Microsoft® Office Suite works completely seamlessly.
For example, the TFORMer SDK can be embedded into Microsoft® Access™ for printing barcode
labels or generating PDF output.

Within the Microsoft® Office suite VBA (Visual Basic for Applications) is used as programming
language. Thus, the functionality of the TFORMer SDK is also accessible via VBA.

14.2 Hints for Different Office-Versions

This section concentrates on the first steps for integrating the COM component of TFORMer SDK
into a specific Microsoft® Office product.

» Depending on the application it may be necessary to switch to “design” or “edit” mode in
order to create VBA program code.

» Macros must be activated/enabled (Word, Excel...).

» The security settings of the container application must be adjusted to allow active content or
macros. Scripting has to be enabled.

14.2.1 Microsoft Word/Excel 2007-2024 and 365

1. Open or create your document.

2. Enable the developer tab in the ribbon:
File » Options » Customize Ribbon » enable Developer Tab
(or Office Button » Word/Excel Options » Show Developer tab in the Ribbon)

3. Activate the Developer tab.

4. Click Visual Basic to open the Microsoft® Visual Basic editor.
(Alternatively you can also use the shortcut Alt+F17).

5. Click Tools » References and check TFORMer 9 Runtime Type Library to insert a reference
to TFORMer SDK.

6. Click OK.
7. TFORMer SDK can now be used with VBA.

14.2.2 Microsoft Access 2007-2024 and 365

1. Open or create your database.
2. Edit or create a new form (or report) by clicking Create » Form Design (or Report Design).

3. Inthe “Database Tools” (or in the “Report Design”) tab click View Code to open the
Microsoft® Visual Basic editor.
(Alternatively you can also use the shortcut Alt+F17).

4. Click Tools » References and check TFORMer 9 Runtime Type Library to insert a reference
to TFORMer SDK.

5. Click OK.

6. TFORMer SDK can now be used with VBA.
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14.2.3 Microsoft Word 2003 / Excel 2003

Open or create your document.

Activate the Visual Basic-Editor. This can be done by pressing the keyboard shortcut
Alt+F11 or by enabling the Visual Basic toolbar and clicking onto the Visual Basic-Editor
button.

In the Visual Basic editor click Tools » References and check TFORMer 9 Runtime Type
Library to insert a reference to TFORMer SDK.

Click OK.

TFORMer SDK may now be used with VBA.

14.2.4 Microsoft Access 2003

>

7.
8.

Open or create your database.

Create a form or report by selecting Insert » Form (Report) in the menu.

An empty form (or report) is opened.

Make sure the Design view is activated. This can be done by selecting View » Design in the
menu.

Open the Visual Basic-Editor by selecting View » Code in the menu or by clicking the View
Code symbol in the Form Design toolbar.

In the Visual Basic editor click Tools » References and check TFORMer 9 Runtime Type
Library to insert a reference to TFORMer SDK.

Click OK.

TFORMer SDK may now be used with VBA.

14.2.5 Other Microsoft Office versions

The required steps are similar to the steps outlined for Microsoft® Office 2003.

14.3 More Information

For more information, please check out the following documents and sample applications:
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COM Programming Reference

Start Menu » TEC-IT TFORMer 9 SDK » COM Programming Reference
Sample Microsoft Excel Spreadsheet using TFORMer SDK

Start Menu » TEC-IT TFORMer 9 SDK » Microsoft Office
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15 TFORMer in Web Applications

15.1 TFORMer SDK with Web-Applications on Windows

15.1.1 TFORMer SDK on a Windows-based Web-Server

TFORMer SDK at server-side can be used as part of web applications or web services. Server-side
use does not bind your clients to specific browsers or operating systems.

Some .NET based sample applications demonstrate the use of TFORMer SDK with server-based
web applications. Check out the following menu entry:

Start Menu » TEC-IT TFORMer 9 SDK » Programming

15.1.2 Web Based Form Layouts

TFORMer SDK is able to access form layouts, repositories or data files via http/https. When using
tfprint this looks like tfprint -F "http.//something.com/OnlineReport _1.tff" ...

15.1.3 Client-side use of TFORMer SDK

Deprecated: Since MSIE is at its end of life and other browsers stopped support for NPAPI, this
section is for reference only.

When printing from within a web browser the user usually has to confirm the print job by selecting a
target printer (this is due to browser implementation details). You can avoid this limitation by using
the COM component of TFORMer SDK. It enables your web-based application to print to arbitrary
printers without any user interaction.

These are the steps to use the COM based API of TFORMer SDK within web pages on client-side:

1. The TFORMer SDK COM component has to be installed on each client. Take care that only
Microsoft® Internet Explorer can embed the COM component directly. A CAB file for
automatic installation is available from TEC-IT.

2. Use VBScript® or JavaScript™ in a web-page which instantiates a TFORMer class (a sample
using VBScript is installed by the setup). Check out the following menu entry:

Start Menu » TEC-IT TFORMer 9 SDK » Programming

3. Provide the form layouts either locally on the client, on a shared network folder, as BASE64
strings embedded directly into the HTML page or via http:// on an arbitrary server (see
15.1.2).

4. The web page provides data to the TFORMer SDK COM object programmatically.

5. Your web application prints to local printers without any extra user confirmation.

15.2 TFORMer SDK on Linux or UNIX Servers

The TFORMer SDK can be incorporated easily into server-based applications. Your server-based
application (e.g. written in PHP, CGI-Perl, Java, C/C++, ...) invokes tfprint as external process to
generate the output data (e.g. a PDF file).

The TFORMer SDK for Linux/UNIX includes a ready-to-use example showing how tfprint can be
integrated in a web application. The sample application is written in PHP and is installed in:

| /usr/local/share/TFORMer9/SampleCodeCGI

This sample requires a configured apache web server which supports PHP5. To deploy the applica-
tion, all files in the application directory have to be copied into the root directory of the web server.
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The file feedback.php contains the application logic to supply user data using XML to tfprint and to
create a PDF file from the user data and a form layout file.

15.3 TFORMer SDK on Java Web-Applications

Through the Java component of TFORMer SDK, it's possible to build J2EE printing applications and
deploy them into the J2EE Application Server (i.e. Tomcat and JBoss).

This solution permits to print files on server-side, based on certain user configurations or data.

It's important to remember that the Application Server must read the TFORMer DLLs or shared
libraries in order to access to the TFORMer SDK. For details see chapter 11, Java Component.

Check out the following menu entry to find simple examples of JSP/Servlet using the Java
component of TFORMer SDK:

Start Menu » TEC-IT TFORMer 9 SDK » Programming
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16 FAQ

16.1 Linux/UNIX

16.1.1 TFORMer does not work

If there are any problems with the installation of TFORMer SDK we recommend executing the
following script:

$ /usr/local/share/TFORMer9/support.sh

This script is installed by the setup application and lists all relevant information like installed
operating system, library versions and the TFORMer SDK version.

Contact the support of TEC-IT (support@tec-it.com) with the output of this script along with a de-
tailed error description.

16.1.2 TFORMer SDK does not print texts (32 bit TFORMer on 64-bit systems)

The output generated by the TFORMer SDK only contains images, lines, rectangles or similar ele-
ments. Text elements are not shown.

Most likely this problem occurs if you are using a 32-bit build of TFORMer on a 64-bit system.
Please make sure iconv/gconv (character set conversion) is installed correctly. (Re-)Install glibc-
32bit using yast to solve the problem.

16.1.3 TFORMer SDK does not print Umlauts (e.g. AOU361iR)

If you are using a text file for data import (e.g. with tfprint) and if this file was generated on Win-
dows, TFORMer is not able to print special characters like A or U.

To avoid this problem, use XML import files (this is the recommended way). Another possibility is to
convert the text file with iconv to UTF-8 (TFORMer SDK uses UTF-8 internally on Linux/Unix
platforms):

$ iconv —f Windows-1252 —t UTF-8 —o output.csv input.csv

16.1.4 Fonts are looking strange / Errors in the generated layout

When generating output TFORMer tries to match fonts available on your system with fonts used in
the form layout.

Most likely the form layout uses Windows-based fonts (like Arial) which are not available on your
box. If an exact font matching is not possible the output may look strange. In order to avoid this
behavior, install the required fonts on your Linux/UNIX machine.

Use the following commands which are part of the fontconfig package to install new fonts:

= fc-list: list all of the fonts currently available on your box.
= fc-cache: add additional fonts.
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Simply copy the required fonts (*.ttf) to the directory /usr/share/fonts/local/ or to the “/.fonts” sub
directory of the user’'s home (e.g. /home/user/.fonts).

Then run fc-cache. The fonts are always installed for the user, who runs the fc-cache command.
Make sure this is the same user, which uses the TFORMer SDK.

Check out the man pages of your system for an exact description of the fontconfig commands.

16.1.5 The Library libTFORMer9 cannot be found

Make sure the shared library libTFORMer9.a can be found by the linker. Usually this library is
installed in

| /usr/local/lib/

Some platforms require that you add this path to your linker options (e.g. —L/usr/local/lib).

16.1.6 TFORMer Include Files are not found

Make sure the TFORMer include files can be found by the compiler. Usually, these files are
installed in

| /usr/local/include/
Some platforms require that you add this path to your compiler options (e.g. —l/usr/local/include).
16.1.7 ZLib was not found on HP-UX

When creating PDF files, the following warning is displayed:

| Warning: ZLib was not found. Compression support will be disabled.
When you see this warning message an uncompressed PDF file will be created.

On HP-UX make sure that the directory containing libz.so is in your SHLIB_PATH environment
variable.

$ export SHLIB_PATH=/usr/local/lib/hpux32

16.1.8 The EURO sign (€) does not work on AIX

This is a known bug of the TFORMer SDK on AlX. Currently there is no solution available.
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17 Contact and Support Information

17.1 Free Support
If you have questions, need help or simply want to tell us about your application, contact:

Email: support@tec-it.com

Web: www.tec-it.com/support

17.2 How to Unlock the Demo Version

You can unlock the demo version with a license key. License keys can be obtained from TEC-IT by
email, online order form or fax.

Email: sales@tec-it.com
Online: www.tec-it.com/order
Fax: +43/(0)7252/72720-77

17.3 Your Feedback is Welcome!

Don’t hesitate to contact us — let us hear your feedback! If the product does not fulfill your require-
ments, please tell us why. We are highly interested in meeting the requirements of our customers.

17.4 Company Contact Information

TEC-IT Datenverarbeitung GmbH

Address: Hans-Wagner-Str. 6
AT-4400 Steyr
Austria/Europe

Phone: +43/(0)7252/72720
Fax: +43/(0)7252/72720-77
Email: support@tec-it.com

Web: www.tec-it.com

AlX is a registered trademark of IBM Corporation.

HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C, World Wide Web Consortium, Laboratory for Computer
Science NE43-358, Massachusetts Institute of Technology, 545 Technology Square, Cambridge, MA 02139.

JAVA® is a registered trademark of Sun Microsystems, Inc., 901 San Antonio Road, Palo Alto, CA 94303 USA.

JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by
Netscape.

Microsoft®, Windows, Microsoft Word®, Microsoft Excel® are registered trademarks of Microsoft Corporation.

Navision is a registered trademark of Microsoft Business Solutions ApS in the United States and/or other countries.

Oracle® is a registered trademark of Oracle Corporation.

PCL® is a registered trademark of the Hewlett-Packard Company.

PostScript is a registered trademark of Adobe Systems Inc.

SAP, SAP Logo, R/2, R/3, ABAP, SAPscript are trademarks or registered trademarks of SAP AG in Germany (and in several other countries).

All other products mentioned are trademarks or registered trademarks of their respective companies. If any trademark on our web site or in this
document is not marked as trademark (or registered trademark), we ask you to send us a short message (mailto:office@tec-it.com)
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Appendix A: Terms and Definitions

A.1 Form Layout

A form layout is a document created with TFORMer Designer. It is basically an XML-file, which
stores all layout information with the corresponding parameters like position, font-size, color ...

A form layout usually contains static and dynamic data. Dynamic data is provided by a datasource
and used via datafields in the form layout.

A form layout is either stored in a repository (*.tfr) or stored as a stand-alone form layout (*.tff).

A.2 Stand-Alone Form

A stand-alone form is a document, which is stored as single file and which is not contained in a
repository. TFORMer Designer normally creates stand-alone forms, but it can be instructed to add
forms to a repository. Stand-alone forms are using the file extension *.tff.

All required information of a stand-alone form is contained in the layout — therefore it can be printed
by its own.

Stand-alone form layouts are the most basic type of layout definitions and are very easy to use.

A.3 Repository

A repository is a central location in the file system for storing form layouts. Furthermore, the
repository contains datasources and datafields, which may be defined once for multiple layouts.

The main file of a repository is using the file extension *.tfr. The subdirectories are named like the
projects — and these subdirectories are holding the single form layouts. Therefore, moving or
copying a repository must always include the subdirectories!

Using a repository simplifies maintenance of multiple form layouts which share the same datafields.
In addition, a repository is a must with TFORMer Server.

When printing a repository-based form the user must specify the name and path of the repository,
the project within the repository and the name of the form layout.

A.4 Project

A repository is divided into so-called projects. Each project holds definitions for datasources,
datafields and one or more form layouts. All form layouts using the same datafields and/or
datasources should be grouped in a project.

A.5 Datafield

A form layout may use datafields as place-holders for dynamic data. The content of these
placeholders is provided during runtime (= print-time) by external datasources or by the user. At
runtime each occurrence of a datafield is replaced with the current data. Datafields may be used as
part of expressions.
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In contrast to a stand-alone form which stores all datafield definitions itself, a repository-based form
may use datafields defined in the project where the document layout is located. That means that all
forms belonging to a project can use the same datafields.

In addition to such project-specific datafields TFORMer supports global datafields. These datafields
are available for all document layouts in all projects.

A.6 Template

A template is a document layout, which has been stored in the template database of TFORMer
Designer. If you select “New Form” in TFORMer Designer you can start your actual document
layout based on such a template.

TFORMer Designer is shipped with various predefined templates like industry compliant labels. The
user can also create his own templates by saving them to the template database.

Templates are stored per default in the following directory:

| C:\ProgramData\TEC-IT\TFORMer\9\Templates

This directory can be changed by modifying the registry (see TFORMer Designer User Manual).

» Do not edit the files in the template path directly!

A.7 Datasource

Dynamic data is provided by external datasources like in-memory datasources, ODBC databases,
text files, XML files or user input. Whenever printing a form, TFORMer Designer imports the data
from the datasource and generates the output based on this data. The same data set may be used
for the next output session without importing it again (the only exception is an in-memory data-
source. In this case data is not stored by TFORMer).
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Appendix B: Passing Data to TFORMer SDK

B.1 General

During runtime your application supplies data to TFORMer SDK in order to provide values for the
datafields used in a form layout.

For this purpose, three general methods are supported:

= Imported data file
Pass data to TFORMer SDK via a flat text file (e.g. CSV) or via XML files. Take care to
create the files with current data before printing the required form layouts.

= User-defined datasource
The creator of a form layout can also specify a datasource (XML file, TXT/CSV-file, ODBC
queries) in the document layout itself. A unique name is assigned to each data source.
When printing a form layout just specify the name of the datasource and TFORMer SDK
queries the data for printing automatically.

= ODBC
Pass data to TFORMer SDK via an ODBC database. DSN, user, password and the suitable
SQL select statement can be specified as required.

= API (Application Programming Interface)
Pass data to TFORMer SDK via method or function calls. This method is not available for
the command line interface (tfprint).

B.2 XML Files

Three different XML formats can be imported:

= The internal XML-format.
= A generic XML-format.
= The XML-format used in current versions of Microsoft® Access™.

B.2.1 Internal TFORMer XML-Format

The XML format used internally by TFORMer must be available exactly as specified below:

<PSData>
<Form>
<Records>
<Record Copies="1">
<V Name="DataFieldNamel">Value</V>
<V Name="DataFieldName2">Value</V>
<V Name="DataFieldName3">Value</V>
</Record>
<Record Copies="1">
<V Name="DataFieldNamel">Value</V>
<V Name="DataFieldName2">Value</V>
<V Name="DataFieldName3">Value</V>

</Record>
</Records>
</Form>

</PSDhata>
Description:

Name Description

PSData This is the root element. It encloses all data within the xml file.

Form This element encloses all data records for one Form. It must be specified only once in

an XML-file
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Records

Record

DataFieldName
Value

This element encloses all data records to be printed with the enclosing Form.

Must be specified only once in an XML-file.

This element encloses all datafields for one record.

For each record there is one (optional) attribute named “Copies”. The default value (if
the attribute is missing) is 1 — meaning that this record is used once. If you want to use
the same data for multiple records you can specify the number of record copies in this
attribute.

Data-Element.

This element consists of the datafield name (attribute “Name”) and the actual datafield
value.

Name of the datafield (must be unique within a record).

The actual value of the datafield.

B.2.2 Generic XML-Format

The generic XML file allows two variants (see below).

<Root>
<Records>
<Record>

<V Name="DataFieldNamel">Value</V>
<V Name="DataFieldName2">Value</V>
<V Name="DataFieldName3">Value</V>

</Record>

<Record>

<V Name="DataFieldNamel">Value</V>
<V Name="DataFieldName2">Value</V>
<V Name="DataFieldName3">Value</V>

</Record>

Further Data Records

</Records>
</Root>

Description:

Name
Root

Records

Record

DataFieldName

Value

Description

This is the root element. It encloses all data within the xml file.
The element must not necessarily be named “Root”. You can choose a name freely.

This element encloses all data records.

The element must not necessarily be named “Records”. You can choose a name free-
ly.

This element describes one data record. Within a record one value can be specified

for each datafield.
The element must not necessarily be named “Record”. You can choose a name freely.

Data-Element.
This element consists of the datafield name (attribute “Name”) and the actual datafield
value.

Name of the datafield (must be unique within a record).

The actual value of the datafield.

» The nodes must not necessarily be named “Root*, “Records® and “Record®. The names can
be chosen arbitrarily. Only the order of the nodes is decisive. TFORMer interprets the lowest
level of the XML-format as variable definitions and/or datafields. The superordinate nodes
always correspond to data records.

Example:

<Root>
<Records>
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<Record>
<V Name="ArticleName">Chair</V>
<V Name="ArticleNo">558963</V>
<V Name="ArticlePrice">110</V>
</Record>
<Record>
<V Name="ArticleName">Desk</V>
<V Name="ArticleNo">778920</V>
<V Name="ArticlePrice">150</V>
</Record>

Further Data Records

</Records>
</Root>

Same as variant 1, but instead of using the syntax “<V Name="DataFieldName">Value</V>" you
can specify datafield values using the following syntax:

<Root>
<Records>

<Record>
<DataFieldNamel>Value</DataFieldNamel>
<DataFieldName2>Value</DataFieldName2>
<DataFieldName3>Value</DataFieldName3>

</Record>

<Record>
<DataFieldNamel>Value</DataFieldNamel>
<DataFieldName2>Value</DataFieldName2>
<DataFieldName3>Value</DataFieldName3>

</Record>

Further Data Records

</Records>
</Root>

B.2.3 Microsoft Access XML-Format

The XML files which are exported from Microsoft® Access™ looks like this:

<?xml version="1.0" encoding="UTF-8"?>
<dataroot xmlns:od="urn:schemas-microsoft-com:officedata">
<tblTableName>
<DataFieldNamel>Value</DataFieldNamel>
<DataFieldName2>Value</DataFieldName2>
<DataFieldName3>Value</DataFieldName3>
</tblTableName>
<tblTableName>
<DataFieldNamel>Value</DataFieldNamel>
<DataFieldName2>Value</DataFieldName2>
<DataFieldName3>Value</DataFieldName3>
</tblTableName>

Further Data Records

</dataroot>
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B.3 Text Files

TFORMer can import text files in the CSV format (Comma Separated Values) or modifications of
this format. When importing text files you can specify the separator (semicolon, comma, tab, space)
and the text qualifier (= the symbol which encloses the actual values like text strings).

B.3.1 File Format

Text files must be structured as follows:

= The first line in the text file lists all column names (= names of the datafields).
= The following lines contain the datafield values (one record per line).

DataFieldNamel;DataFieldName2; ..;DataFieldNameN

Value;Value; ..;Value
Value;Value; ..;Value

Further Data Records

Example:

ArticleName;ArticleNo;ArticlePrice
Chair;558963;110

Desk;778920;150

Monitor;775116;236

Panel;544593; 40

Coffee Machine;549896; 30
Printer;458862;100

Fax;445866;115

Phone;458932; 50

You have the possibility to use different column separators, line separators and text qualifiers:

Char Description

TAB Tabulator character (\0x09)
; Semicolon (\0x3B)

, Comma (\0x2C)

Space Space character (\0x20)

Other Any other single character.

Char Description

LF Line Feed (\0x0A)

CRLF Carriage Return + Line Feed (\0xOD\0x0A)
Char Description

“ Double quote character (\0x22)
Single quote character (\0x27)
Other Any other single character.

None

Example

Value Value Value
Value;Value;Value
Value,Value,Value

Value Value Value
Value#Value#Value

Example
Text files created under UNIX or LINUX.

Text files created under Windows (or
MS DOS).

Example
“Value”
‘Value’
+ Value+

Value

All characters which are enclosed with a text qualifier are imported as one single value. Thus, you

can use the column separator character in strings, too!
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If you want to use a line break within a string, please use the escape sequence “\n” (new line).
When importing the data, the “\n” will be replaced with a new line character.

B.4 Important Notes

B.4.1.1 Empty or Missing Datafield Values

TFORMer SDK uses the default value of a datafield if no value is defined in the datasource. This
behavior can be adjusted using with tfprint command line parameters (see command line switch
CL[yes|no]).

B.4.1.2 Additional Datafields in an Import File
TFORMer SDK ignores datafields which are not defined in the form design.
B.4.1.3 Use of Escape Sequences (e.g. \n - Newline) in the Datafield Values

Since TFORMer Version 6 escape sequences are not translated automatically. This behavior can
be adjusted via the tfprint command line (see ESC[yes|no]) or via the API.
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Appendix C: Configuration File TFORMer.xml

C.1 General

The TFORMer SDK uses a configuration file which holds basic output settings suitable for most
requirements. This configuration file is named TFORMer.xml and is installed automatically. After
installation it can be adjusted to meet customized output needs.

C.2 Location of TFORMer.xml on Microsoft Windows

When using a Windows operating system, the default TFORMer.xml resides in the directory:

| C:\ProgramData\TEC-IT\TFORMer\9

In addition, TFORMer supports user specific files which override the default. TFORMer Designer
creates this file automatically in a user specific folder:

| C:\Users\**USERNAME* *\AppData\Local \TEC-IT\TFORMer\9

Via an API call the developer may also specify the filename of a specific configuration file which
should be used.

C.3 Location of TFORMer.xml on LINUX or UNIX

When using Linux or UNIX this file is stored in the following directory:

| /usr/local/share/TFORMer9

C.4 Configuration File TFORMer.xml

The following settings can be configured:

=  Common options

- Error handling for barcodes, images and text-elements with expressions
- Settings for downloading pictures from an URL for printing

PDF output options

- page setup (size, orientation, compression, margins, embedding of fonts)
- image compression method (and jpeg-quality)

- maximum resolution for images (down-sampling)

PostScript output options

- page setup (size, orientation, color-mode)

- external header/footer file

- character encoding

HTML output options

- page setup (size, resolution)
- barcode output options (optimize for readability, print unreadable barcodes)

ZPL-Il (ZEBRA printers) output options
= Barcode generator options

- drawing method for windows printers
= Paper format names (for trays)

File dump of the default TFORMer.xml configuration file:
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<?xml version="1.0" encoding="UTF-8"?>
<TFORMer major="1" minor="0">

<!-- (c) 1998-2025 TEC-IT Datenverarbeitung GmbH ==
<!-- htpp://www.tec-it.com -—>
<!-- support@tec-it.com -—>
<!-- This TFORMer configuration file contains standard settings for the ==
<!-- output methods. Edit this file if you want to change specific output ==
<!-- options or if you need to add custom media sizes. -—>
<!-- Note: In previous versions the term <Form> was used instead of <Media> -—>
<!-- COMMON Options - Configure settings that apply to all printers -—>
<COMMON>

<!-- ErrorHandling -—>
<!-- Decides what TFORMer does if a barcode, image or expression error occurs -=>
<!-- during printing. All 3 attributes accept the following arguments: —-=>
<!-- * abort Abort printing if an error occurs ==
<!-- * ignore Ignore the error and continue printing -—>
<!-- * print Print error information instead of the component that -=>
Ll== caused the error —-=>

<ErrorHandling barcode-error="print" image-error="print"
expression-error="print" unicode-font-error="print"
mediasource-error="abort" />

<!-- URLPictures —-=>
<!-- Specifies how TFORMer handles requests for downloading pictures via URL. -=>
<!-- URLPictures are supported on Windows systems only. ==
<!-- enabled "0|1" enable/disable downloading of images ==
<!-- size-max the maximum bytes per picture allowed. "0" = unlimited -->
<!-- timeout the download time in [ms] allowed per picture. -——>
<l-- "0" = no timeout -=>

<URLPictures enabled="1" size-max="0" timeout="0" />

<!-- Hyphenation —-=>
<!-- soft-hyphens characters which should be treated as soft hyphens ==
<l== (additional to &shy; and &#173;) -——>
Ll== A soft hyphen marks a point at which a word may be ==
Ll== divided. If the word is divided, then a hyphen is ==
K== displayed at the end of the line, otherwise the hyphen -->
K== is not displayed. ==
<l-- Sample: "$&#174;" to add 2 additional softhyphens >
<!-- hyphen value which should be used to render visible >
K== soft hyphens ==
<Hyphenation soft-hyphens="" hyphen="-" />
<!-- TextFile ==>
<!-- encoding default encoding for CSV data sources using the ==
K== standard text encoding and for importing text files ==
<ll== via the SDK. Used when no file BOM is present. ==>
<l-- Supported values are: ==>
<l-- - "default" ==
<Il-—- - "system", ansi(for Windows), utf-8(on other O0S) ——>
<l-- - "ansi" ==>
<ll== - "utf-8" -—>
Ll== - "utf-1le" ==
Ll== - "utf-16be" ==

<TextFile encoding="default" />

</COMMON>

<!-- PDF OPTIONS - Configure settings for PDF output ==
<!-- media Default media size, must be listed in <DefinedMedia> -——>
<!-- orientation Default orientation "landscape|portrait" -—>
<!-- compression Enable/disable zip compression of the PDF "1|0" ==
<!-- margin-top Additional top margin of the page in 1/1000mm ==
<!-- margin-left Additional left margin of the page in 1/1000mm -—>
<!-- margin-right Additional right margin of the page in 1/1000mm —-=>
<!-- margin-bottom Additional bottom margin of the page in 1/1000mm ==
<!-- embed-fonts Embed all TrueType fonts in the document "O|1" ==
<!-- embed-subset-fonts Embed all TrueType fonts as subset "O|1" ==>
<l-- This will usually result in smaller PDF files. —-=>
<!-- embed-type3-fonts Embed all fonts as type3 fonts which are some times ==>
<l-- smaller, but might look bad on screen. "O|1" -—=>
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<!-- colormode color|grayscale|blackwhite —-=>
<!-- simulate-font-styles if 1 TFORMer will simulate bold fonts for fonts -—>
Lll== that are not available as bold on this system. ==
<PDF media="A4" orientation="portrait" compression="1" margin-top="0" margin-left="0"
margin-right="0" margin-bottom="0" embed-fonts="1" embed-subset-fonts="0"
embed-type3-fonts="1" colormode="color" simulate-font-styles="1" >

<!-- compression-method "jpegl|zip|lauto": -—>
<l-- - "jpeg" all images will be jpeg compressed -=>
<l —= - "zip" all images are zip compressed -=>
<l == - "auto" wuse jpeg compression for jpegs, else zip -—=>
<!-- jpeg-quality jpeg quality setting for jpeg compression (0-100) >

<Images compression-method="auto" Jjpeg-quality="80">

<!-- Images can be downsampled if they are higher than the specified resolution -->
<!-- enabled "0|1l" enable/disable downsampling of images -—>
<!-- dpi all images are downsampled to this resolution -—>
<Downsample enabled="1" dpi="300" />

</Images>
<!-- user-password password required for opening a document ==
<!-- owner-password password required to change user permissions —-—>
<!-- printing-permission "none|low-resolution|high-resolution": ==
<!l-- - "none" disallow printing -=>
<l-- - "low-resolution" allow only low-resolution printing -->
<l-- - "high-resolution" allow full printing —-=>
<!-- modify-permission "none|assembly|annotate|all": -=>
Lll== - "none" allow no modifications ==
K== - "pages|assembly" allow document assembly only ==
<l-- - "comments|annotate" assembly permissions plus commenting -->
El== - "all" allow full document modification ==>
<!-- allow-copy-content "O|1" allow copying of any content ==
<!-- allow-screen-reader-text—-access "O|1" ——>
<!-- encrypt-content "all |exclude-meta-data": ==>
<l-- - "all" encrypt all content ==>
<l-- - "exclude-meta-data" prevent encryption of metadata ==>

<Security user-password="" owner-password="" printing-permission="high-resolution"

modify-permission="none" allow-copy-content="1"
allow-screen-reader-text-access="1" encrypt-content="exclude-meta-data" />

</PDF>

<!-- POSTSCRIPT OPTIONS: Configure settings for PostScript output ==
<!-- media Default media size, must be listed in <DefinedMedia> -——>
<!-- orientation Default orientation "landscape|portrait" ==>
<!-- colormode color|grayscale|blackwhite ——>
<!-- duplex Selects duplex or double-sided printing for printers ==
K== capable of duplex printing. —-=>
<l-- "default|simplex|vertical|horizontal": >
K== - "default" use printer settings ==
K== - "simplex" normal (nonduplex) printing ==
<!l-- - "vertical" double-sided printing using a >
K== vertical page turn ==>
K== - "horizontal" double-sided printing using a ==
K== horizontal page turn ==
<!-- Header Path to the PostScript header file ==>
<!-- Footer Path to the PostScript footer file ==>

<POSTSCRIPT media="A4" orientation="portrait" colormode="color" duplex="default" >
<Header filename="header.ps" />
<Footer filename="footer.ps" />

<!-- compression-method "nocomp|jpegl|flate|rlelauto": ==>
Ll== - "nocomp"no compression ==
Ll== - "jpeg" non monochrome images will be jpeg compressed-->
<l-- monochrome images will use flate or rle ==>
<l-- compression ==>
Ll== - "flate" all images will be flate compressed ==
Ll== - "rle" all images will be run length encoded ==
<l-- - "auto" depends on jpeg-enabled and flate-enabled ==>
<l-- uses jpeg compression for jpeg files —-—>
<l-- flate or rle for others —-=>
<!-- jpeg-quality jpeg quality setting for jpeg compression (0-100) ==
<!-- jpeg-enabled enables jpeg compression for auto compression mode ==>
<!-- flate-enabled enables flate compression for auto compression mode —-=>
Ll== requires Postscript Language Level 3 support ==>
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<Images compression-method="auto" jpeg-quality="75" jpeg-enabled="1" flate-enabled="0"

>
<!-- Images can be downsampled if they are higher than the specified resolution -->
<!-- enabled "0|1l" enable/disable downsampling of images -—>
<!-- dpi all images are downsampled to this resolution -—>
<Downsample enabled="1" dpi="300" />
</Images>

</POSTSCRIPT>

<!-- HTML OPTIONS: Configure settings for HTML output —-=>
<!-- media Default media size, must be listed in <DefinedMedia> -——>
<!-- orientation Default orientation "landscape|portrait" -——>
<!-- 96 dpi - this should be used as default resolution for browser apps ==
<!-- 108 dpi - seems to work better on Linux machines (depends on module width) -->
<!-- 72 dpi - might be a good choice if your target audience is on MAC OS ==
<l-- -
<!-- barcode-opt-resolution print barcodes in optimal resolution -=>
<l== This will create readable barcodes which —-=>
<l-- might look different as in design mode. —-=>
<!-- always-print-barcodes will print barcodes even if they will be ==
<l-- not readable. This is ONLY useful for -=>
Zll== preview purposes. -

<HTML media="A4" orientation="portrait" resolution="96" barcode-opt-resolution="0"
always-print-barcodes="1" />

<!-- IMAGE OPTIONS: Configure settings for image output ==
<!-- media Default media size, must be listed in <DefinedMedia> -->
<!-- orientation Default orientation "landscape|portrait" -=>
<!-- resolution The output resolution in dpi. -=>
<!-- anti-aliasing 1 = enabled —-=>
<l-- 0 = disabled —-=>
<!l-- Anti-aliasing improves the quality of the output -=>
<!l-- in lower resolutions or for on screen display. -=>
<!-- jpeg-quality jpeg quality setting for jpeg compression (0-100) —-=>
<!-- tiff-compression Compression of generated tiff images. —-=>
El== A few compression schemes are only allowed for b&w ==>
K== or color output. Suggested values that should always -->
K== work are: nocomp, lzw or jpeg ==
<l-- Valid values: —-=>
<l== nocomp, lzw, packbits, ccitt3, ccittd4, ccittfax, jpeg -->
<!-- colormode color|grayscale|blackwhite ——>
<!-- dither-mode Specifies how images are converted to black&white ==
<l-- Applies only if colormode="blackwhite" —-=>
Lll== 0 = Use scatter dithering (simulates grayscale) ==>
K== 1 = Use ordered dithering (simulates grayscale) ==
<Il-—- 2 = Use threshold dithering (results in bé&w only) ——>

<IMAGE media="A4" orientation="portrait" resolution="200" anti-aliasing="1"
jpeg-quality="80" tiff-compression="nocomp" colormode="color" dither-mode="0" />

<!-- ZEBRA OPTIONS: Configure options for Zebra/ZPL output ==
<!-- media Default media size, must be listed in <DefinedMedia> -->
<!-- orientation Default orientation "landscape|portrait" ==>
<!-- compression Image compression for graphics embedded in ZPL ==
K== 'none' = no compression, data is hex encoded ==
== 'rle' = data is run-length-encoded ==>
<l-- 'png' = data is png and base64 encoded >
K== 'zip' = data is zip compressed and base64 encoded ==
<!-- dont-dither-text Text will always be drawn black, no dithering occurs -->
<ll== This leads to improved text quality ==>
<!-- dither-mode Specifies how images are converted to black&white ——>
Kll== 0 = Use scatter dithering (simulates grayscale) -—>
Ll== 1 = Use ordered dithering (simulates grayscale) ==
<l-- 2 = Use threshold dithering (results in bé&w only) -—=>
<!-- scaling Resolution mode of the Zebra printer device -—>
<l-- 0 = normal resolution ("JMA Command) ——>
<l-- 1 = half resolution, doubled output size (~JMB Cmd) -—=>
<!-- resolution resolution of the printer in dpi ==
<I== T metric value for "“LT (label top) command —-=>
Lll== Default unit is mm, if required you can specify other -->
<l== units like in, cm, m, mil, etc. (Default: 0 mm) ==>
Ll== provide an empty value to omit the command ==
<!-- 1s metric value for ~LS (label shift) command -—>
Ll== Default unit is mm, if required you can specify other -->
<l== units like in, cm, m, mil, etc. (Default: 0 mm) ==>
Ll== provide an empty value to omit the command ==>
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<!-- Header custom ZPL code that is printed before each print-job -->

<!-- Footer custom ZPL code that is printed after each print-job -->

<ZEBRA media="A4" orientation="portrait" compression="rle" scaling="0"
dont-dither-text="1" dither-mode="0" resolution="203" 1t="0 mm" 1s="0 mm" >

<Header></Header>
<Footer></Footer>

</ZEBRA>

<!-- Settings for Windows Printers —=>

<WINGDI>
<!-- drawing-mode Specifies the method for printing barcodes on GDI -=>
K== 0 = Default method ——>
<l-- 1 = Compatibility mode —-=>
== Use the GDI rectangle functions to draw bars. -—>
<l-- May result in sub-optimal output quality, -—>
<l-- but is compatible to all printers. -—>
== 2 = Quality mode -=>
== Best quality. Supported by most printers. -—>
K== 3 = Dual ==
<l-- A combination of 1 and 2 -=>

<TBARCODE drawing-mode="1" />

<!-- transparent-drawing-mode ==
<l-- Specifies the drawing method for transparent images -=>
<l== on Win32 printers (trouble shoot printer issues) -——>
<l-- 'default' = Default method ==>
<l-- 'auto' = tries to determine best method -=>
<l-- 'TransparentBlt' = use GDI TransparentBlt method ==
<l-- 'MaskBlt' = use GDI MaskBlt method ==>
<l-- 'BitBlt' = use combination of BitBlts, needs access -->
<!-- to device pixels -=>
<l-- 'Opaque' = ignore transparency and print image opaque-->
<Images transparent-drawing-mode="default" />
</WINGDI>
<!-- SVG Options: Configure options for Scalable Vector Graphics output -->
<!-- media Default media size, must be listed in <DefinedMedia> -->
<!-- orientation Default orientation "landscape|portrait" ==
<!-- colormode color|grayscale|blackwhite ==>
<!-- minify Specifies whether the SVG output is minified ==
<Il-—- 1 = removes unnecessary line breaks and indentation, ——>
K== metadata is omitted >
<l-- 0 = formats output for readability, includes >
K== line breaks, indentation and metadata ==

<SVG media="A4" orientation="portrait" colormode="color" minify="0">

<!-- weld "0O|1" enables or disables merging (welding) of adjacent-->
L[ == shapes into a single path ==
Ll== (default: 1) ==>

<Barcodes weld="1" />

<!-- compression-method "auto|jpeg|png": ==
L[ == - "auto" Jjpeg images stay jpeg compressed ==
Lll== all others, including monochrome or —-=>
K== transparent images will use png compression -->
L[ == - "jpeg" images will be jpeg compressed ==
L[ == monochrome or transparent images will use ==
K== png compression ==>
Ll== - "png" all images will be png compressed —-=>
<!-- jpeg-quality jpeg quality setting for jpeg compression (0-100) ——>

<Images compression-method="auto" jpeg-quality="80">

<!-- Images can be downsampled if they are higher than the specified resolution -->
<!-- enabled "0|1" enable/disable downsampling of images -—>
<!-- dpi all images are downsampled to this resolution ==
<Downsample enabled="0" dpi="300"/>
</Images>
</SVG>
<!-- DEFINED MEDIA SIZES ==>
<!-- Add YOUR CUSTOM MEDIA-SIZES to the list and use them in TFORMer ==>
<!-- Use them by specifying the name of the media as output tray name —-—>
<!-- (enter the custom name directly into the tray option in TFORMer Designer) -->
<!-- All measurements are specified in 1/1000 millimeters ==>
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<DefinedMedia>

<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
<Media
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name="A0"
name="A1"
name="A2"
name="A3"
name="A4"
name="A5"
name="A6"
name="A7"
name="A8"
name="A9"
name="A10"
name="B0O"
name="B1"
name="B2"
name="B3"
name="B4"
name="B5"
name="B6"
name="B7"
name="B8"
name="B9"
name="B10"
name="CQ0"
name="C1"
name="C2"
name="C3"
name="C4"
name="C5"
name="C6"
name="C7"
name="C8"
name="C9"
name="C10"
name="D0"
name="D1"
name="D2"
name="D3"
name="D4"
name="D5"
name="D6"
name="D7"
name="EQ"
name="E1"
name="E2"
name="E3"
name="E4"
name="E5"
name="E6"
name="E7"

name="B0JIS"
name="B1JIS"
name="B2JIS"
name="B3JIS"
name="B4JIS"
name="B5JIS"
name="B6JIS"
name="B7JIS"
name="B8JIS"
name="B9JIS"
name="B10JIS"
name="Invoice"
name="Executive"
name="Legal"

name="JuniorLegal"

name="Letter"
name="Ledger"
name="Tabloid"

name="Broadsheet"

name="Screen"
name="Custom"
name="Comml0"

name="DL"
name="Folio"
name="P1"

width="841000"
width="594000"
width="420000"
width="297000"
width="210000"
width="148000"
width="105000"
width="74000"
width="52000"
width="37000"
width="26000"
width="1000000"
width="707000"
width="500000"
width="353000"
width="250000"
width="176000"
width="125000"
width="88000"
width="62000"
width="44000"
width="31000"
width="917000"
width="648000"
width="458000"
width="324000"
width="229000"
width="162000"
width="114000"
width="81000"
width="57000"
width="40000"
width="28000"
width="771000"
width="545000"
width="385000"
width="272000"
width="192000"
width="136000"
width="96000"
width="68000"
width="800000"
width="560000"
width="400000"
width="280000"
width="200000"
width="140000"
width="100000"
width="70000"
width="1030000"
width="728000"
width="515000"
width="364000"
width="257000"
width="128000"
width="128000"
width="91000"
width="64000"
width="45000"
width="32000"
width="140000"
width="191000"
width="215900"
width="203200"
width="215900"
width="431800"
width="279400"
width="432000"
width="297000"
width="210000"
width="105000"
width="110000"
width="210000"
width="560000"

height="1189000"
height="841000"
height="594000"
height="420000"
height="297000"
height="210000"
height="148000"
height="105000"
height="74000"
height="52000"
height="37000"
height="1414000"
height="1000000"
height="707000"
height="500000"
height="353000"
height="250000"
height="176000"
height="125000"
height="88000"
height="62000"
height="44000"
height="1297000"
height="917000"
height="648000"
height="458000"
height="324000"
height="229000"
height="162000"
height="114000"
height="81000"
height="57000"
height="40000"
height="1091000"
height="771000"
height="545000"
height="385000"
height="272000"
height="192000"
height="136000"
height="96000"
height="1120000"
height="800000"
height="560000"
height="400000"
height="280000"
height="200000"
height="140000"
height="100000"
height="1456000"
height="1030000"
height="728000"
height="515000"
height="364000"
height="257000"
height="182000"
height="128000"
height="91000"
height="64000"
height="45000"
height="216000"
height="254000"
height="355600"
height="127000"
height="279400"
height="279400"
height="431800"
height="559000"
height="210000"
height="297000"
height="241000"
height="220000"
height="330200"
height="860000"

/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
/>
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<Media name="P2"
<Media name="P3"
<Media name="P4"
<Media name="P5"
<Media name="P6"
<!-- add custom forms
<Media name="KLT"
<Media name="KLT2"
<Media name="4x6"
<Media name="4x5"
</DefinedMedia>
</TFORMer>
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width="430000"
width="280000"
width="215000"
width="140000"
width="107000"

below this point -->

width="210000"
width="210000"
width="101600"
width="101600"

height="560000"
height="430000"
height="280000"
height="215000"
height="140000"

height="74000"
height="42000"

height="152400"
height="127000"

/>
/>
/>
/>
/>

/>
/>
/>
/>
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Appendix D: Distribution and Deployment for
Microsoft Windows

D.1 Core Requirements

If you want to use the TFORMer SDK within your own application (or on the command line) you
have to distribute the files listed below. These files must be shipped in order to enable basic
TFORMer features and to offer complete printing support on Microsoft® Windows based printers.
You need to deploy the x64 versions only if required (if you are using the 64-bit SDK).

= TFormer9.dll (the main DLL for TFORMer SDK required in each case)
= TFormerRep9.dll

= TECBaseU.dIl

= TFPrint.exe (required for command-line printing only)
= FreelmageMT.dIl

= freeimage.LICENSE

= freetype248MT.dII

= freetype.LICENSE

= jconvx32.dll

= jconv.LICENSE

= libart_Igpl.LICENSE

= libxmlI2x32.dll

= libxmI2.LICENSE
= libxsltx32.dll

= zlib1.dll

= zlib.README

= TFORMer.xml (contains system-wide output options like page size, PDF compression
mode, and more — see Appendix C)

Additionally, the Microsoft Common Runtime DLLs (Visual C++ 2015-2022 runtime components)
are required on the target system.

= You can install the components with the Microsoft Visual C++ 2015-2022 Redistributable
Package (x86) available at
https://aka.ms/vs/17/release/vc redist.x86.exe
and (x64) available at
https://aka.ms/vs/17/release/vc redist.x64.exe
The package installs all required runtime DLLs.

Please note:
TFORMer 9.0.0 Requires Microsoft® Visual C++ 2015-2022 Redistributable Package (x86).

Please contact TEC-IT Support if you need help.

D.2 Licensing

If you are redistributing the TFORMer SDK as part of your application, please use programmatic
licensing. This allows you to securely embed or protect your license key.

If you are using the TFORMer SDK in a web or server application, you can also apply the license by
deploying this additional license file:
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= TFORMer.ini

(should be located in the SDK deployment or installation path — when using the default
TFORMer SDK installation, you could copy it to

"C:\Program Files\TEC-IT\TFORMer9 SDK" or

"C:\Program Files (x86)\TEC-IT\TFORMer9 SDK")

For detailed information, please refer to the API Reference: Related Pages » Licensing TFORMer.

D.3 API Specific Requirements

D.3.1 COM API
If you want to use the COM based interface of TFORMer SDK, this additional DLL is required:

= TFORMerCOM9.dII
This DLL provides the COM interface; mark TFORMerCOM9.DLL as self-registering file (or
use "regsvr32.exe TFORMerCOM9.d11")

D.3.2 .NET API
If you want to use the .NET interface of TFORMer SDK, this additional DLL is required:

= TECIT.TFORMer.dIl
This DLL provides the .NET interface; it is installed by default in the GAC as well as in the
Program Files folder.

» For executing .NET code, the Microsoft .NET Framework 4.5 or higher is required! A redis-
tributable package of the framework is available at
https://dotnet.microsoft.com/download/dotnet-framework

D.3.3 JAVAAPI
If you want to use the JAVA interface of TFORMer SDK, these additional files are required:

= JTFORMer9.jar
= TFORMer9JNL.dII

> Please note that the JAR file is compatible with version 1.5 and higher of the Java Runtime
Edition (JRE)

D.4 Requirements for PostScript/HTML Output

In addition, ship the following files whenever native PostScript/HTML output is required. These files
support font-handling on non-Windows based output devices.

= header.ps (Required only for native PostScript compatible output)
= footer.ps (Required only for native PostScript compatible output)
= template.html (Required only for native HTML compatible output)
= footer.html (Required only for native HTML compatible output)

D.5 Distribution of TFORMer Document Layouts

Ship your TFORMer Form Layouts as part of your application.
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= Repository based Form Layouts
Ship the Repository (*.tfr file) and all subdirectories (Forms/*). Make sure to include all files
(*.xmd, *.xml, embedded images) and take care to preserve the directory structure below
the * tfr file!

= Stand-alone Form Layouts
Ship all the *.tff file(s) and the corresponding *.xml data file(s) as well as embedded image
files.

= ZIP files containing the files mentioned above
TFORMer SDK is able to handle zip-files directly. When using ZIP-files take care to include
all files as mentioned above and preserve the directory structure (relative to the *.tfr or *.tff
file) within the ZIP-file.

= Instead of shipping files you can also pass Form Layouts in BASE64 encoded strings.
TFORMer SDK is able to handle BASEG4 strings which contain a Form Layout or even a
complete Repository. The files for the Form Layout or Repository may also be zipped
(including all required image files) before being BASE64 encoded. Pass the BASE64
encoded strings with the prefix “BASE64 : ” instead of filenames to the TFORMer SDK
functions.
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Appendix E: Distribution and Deployment for
Linux® or UNIX®

E.1 Core Requirements

If you want to use the TFORMer SDK within your own application (or on the command line) you
have to distribute the files listed below:

= |ibTFORMer9.so
(must be accessible through the library search path)

= TFORMer.xml
(should be located in " /usr/local/share/TFORMer9/" — otherwise the path to the file
must be specified with TFORMer_SetConfigFile())

Furthermore, the following libraries are required on the target system:

= LibXmiI2

= LibXslt

= Freelmage

= FreeType2

= FontConfig

= ZLib

= LibArt LGPL (optional — required for image output)

= CUPS (optional — required for direct printing under Linux)
= UnixODBC (optional — required for SQL support)

E.2 Licensing

If you are redistributing the TFORMer SDK as part of your application, please use programmatic
licensing. This allows you to securely embed or protect your license key.

If you are using the TFORMer SDK in a web or server application, you can also apply the license by
deploying this additional license file:

= TFORMer.ini
(should be located in the TFORMer SDK deployment or installation path — when using the
default TFORMer SDK installation, you could also copy it to
"/usr/local/share/TFORMer9")

For detailed information, please refer to the API Reference: Related Pages » Licensing TFORMer.

E.3 API Specific Requirements

E.3.1 Shared Library / DLL

» For compiling C/C++ projects under Linux or UNIX you need to install the FontConfig and
FreeType2 development packages!
Try the following command to install them:
apt-get install libfontconfigl-dev
apt-get install libfreetype6-dev
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E.3.2 .NET API

If you want to use the .NET interface of TFORMer SDK, this additional DLL is required:
= TECIT.TFORMer.dll
E.3.3 JAVA API
If you want to use the JAVA interface of TFORMer SDK, these additional files are required:

= JTFORMer9.jar
= TFORMer9JNL.dII

» Please note that the JAR file is compatible with version 1.5 and higher of the Java Runtime
Edition (JRE)

E.4 Requirements for PostScript/HTML Output

Ship the following files whenever native PostScript/HTML output is required.

= header.ps (Required for native PostScript compatible output)
= footer.ps (Required for native PostScript compatible output)
= template.html (Required for native HTML compatible output)
= footer.html (Required for native HTML compatible output)

E.5 Distribution of TFORMer Document Layouts

See section D.5!
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